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Rockwell Automation, Inc. 

MicroLogix, SLC500 Series 

DF1 Driver  
 Supported version TOP Design Studio V1.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. External device setting Page 10 

 Describes how to set up communication for external devices. 

5. Cable table Page 11 

 Describes the cable specifications required for connection. 

6. Supported addresses Page 13 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of the driver “Rockwell Automation – MicroLogix/SLC500 Series” is as follows: 

 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

MicroLogix 

MicroLogix1500 

(1764-LRP) 
Channel 1 RS-232C 

3.1 Settings 

example 1 

(Page 4) 

5.1. Cable table 1 

(Page 9-(A)) 

MicroLogix 1000 

MicroLogix 1200 

MicroLogix 1500 

(1764-LSP, 1764-LRP) 

Channel 0 RS-232C 

3.1 Settings 

example 1 

(Page 4) 

5.2. Cable table 2 

(Page 9-(B)) 

AIC  +  1761-NET-

AIC (Advanced 

Interface Converter) 

RS-232C 

3.1 Settings 

example 1 

(Page 4) 

5.3. Cable table 3 

(Page 9-(C)) 

SLC500 

SLC 5/03  

SLC 5/04  

SLC 5/05 

Channel 0 RS-232C 

3.1 Settings 

example 1 

(Page 4) 

5.1. Cable table 1 

(Page 9-(A)) 

1770-KF3  

2760-RB  

1775-KA  

5130-RM 

RS-232C 

3.1 Settings 

example 1 

(Page 4) 

5.3. Cable table 3 

(Page 9-(D)) 

1771-KGM RS-232C 

3.1 Settings 

example 1 

(Page 4) 

5.3. Cable table 3 

(Page 9-(E)) 

 

 

■ Connection configuration 

 

ㆍ1:1 (one TOP and one external device) connection  
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “Rockwell Automation, Inc”. 

PLC Select the model series of the external device that connects to the TOP. 

Select “MicroLogix/SLC500 Series DF1”.  

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > “Use HMI Setup” Check > Edit > Serial] 

– Set the TOP communication interface in TOP Design Studio. 

 
 

 
 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 RS-485 

RS-232C 

RS-422/485 
 

Baud Rate 38400  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [Project > Project Property > Device Setting > COM> “PLC1 : Control/Compact Logix Series”] 

– Set the options of the DF1 communication driver in TOP Design Studio. 
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Serial] 
 

 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 RS-485 

RS-232C 

RS-422/485 
 

Baud Rate 38400  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the port (COM1/COM2/COM3) settings you want to use in [Control Panel > Serial] are the same as those of the external 

device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

Set as below using “MicroLogix/SLC500 Series” Ladder Software “RSLogix 500”. For more detailed setting method than that 

described in this example, refer to the PLC user manual.  
 

 
Do not configure a duplicate Source ID (prefix) for the external device connected to the same unit 

network 

 

 

1. From the “RSLogix 500” window, double-click [Channel Configuration] to open the “Channel Configuration“ window. 

2. From the “Channel Configuration” window, select the [Chan. 0 –System] tab, and configure as shown below. 

Setup Items Setup Description Remarks 

Driver DF1 Full Duplex Slave Fixed 

Baud Rate 19200  

Parity NONE  

Stop Bits 1  

Source ID (Station Address) 0  

Protocol Control Control No Handshaking Fixed 

Error Detection BCC Fixed 

Embedded Enabled Fixed 

Duplicate Packet Detect No Check Fixed 

ACK Timeout 50  

NAK Retries 3  

ENQ Retries 3  

3. Download configurations to PLC. 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.) 
 

■ RS-232C (1:1 connection) 

(A) TOP COM Port (9 pin)  

TOP COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin female 

(female, concave) 

RD 2 2 RD 

SD 3 3 SD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

(B) TOP COM Port (9 pin) 

TOP COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1  

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin female 

(female, concave) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4  

SG 5 5 SG 

DSR 6 6  

RTS 7 7  

CTS 8 8  

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

(C) TOP COM Port (15 pin) 

TOP COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

CD 1  

 

 

1  

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin female 

(female, concave) 

RD 2 2 RXD 

SD 3 3 TXD 

DTR 4 4  

SG 5 5 SG 

DSR 6 6  

RTS 7 7  

CTS 8 8  

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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(D) TOP COM Port (9 pin) 

TOP COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 GND 

 

Based on 

communication 

cable connector 

front, 

D-SUB 25 Pin 

female (female, 

concave) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6 DSR 

RTS 7 7 COM 

CTS 8 8 DCD 

 
9 20 DTR 

(E) TOP COM Port (9 pin) 

TOP COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 GND 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin 

female (female, 

concave) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 RTS 

SG 5 5 CTS 

DSR 6 6 DSR 

RTS 7 7 COM 

CTS 8 8 DCD 

 
9 20 DTR 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual  

and be take caution to not deviate from the address range supported by the device you want to use. 

 
Device notation ➔ Device Name File Number : Element 

 

 

6.1 MicroLogix Series 

 

 

Device Bit Address Word Address 32 bits Remarks 

Output File O000:000.00 – O008:255.15 O000:000 – O008:255 

L/H 

 

Input File I000:000.00 – I008:255.15 I000:000 – I008:255  

Bit File B003:000.00 – B003:255.15 

B009:000.00 – B255:255.15 

B003:000 – B003:255 

B009:000 – B255:255 

 

Timer File Coil  Done TC004:000.13 – TC004:255.13 

TC009:000.13 – TC255:255.13 

– 

 

 Timing TC004:000.14 – TC004:255.14 

TC009:000.14 – TC255:255.14 

 Enable TC004:000.15 – TC004:999.15 

TC009:000.15 – TC099:999.15 

 Preset – TP004:000 – TP004:255 

TP009:000 – TP255:255 

 Accumulated – TA004:000 – TA004:255 

TA009:000 – TA255:255 

Counter 

File 

Coil Update Acc CC005:000.10 – CC005:255.10 

CC009:000.10 – CC255:255.10 

– 

 

Underflow CC005:000.11 – CC005:255.11 

CC009:000.11 – CC255:255.11 

Overflow CC005:000.12 – CC005:255.12 

CC009:000.12 – CC255:255.12 

Done CC005:000.13 – CC005:255.13 

CC009:000.13 – CC255:255.13 

Down Enable CC005:000.14 – CC005:255.14 

CC009:000.14 – CC255:255.14 

Up Enable CC005:000.15 – CC005:255.15 

CC009:000.15 – CC255:255.15 

 Preset 
– 

CP005:000 – CP005:255 

CP009:000 – CP255:255 

 Accumulated 
– 

CA005:000 – CA005:255 

CA009:000 – CA255:255 

Integer File N007:000.00 – N007:255.15 

N009:000.00 – N255:255.15 

N007:000 – N007:255 

N009:000 – N255:255 

 

Floating Point File – F008:000 – F255:255 H/L  

String File – ST9:0 – ST255:255 
L/H 

  

Long Word File L9:0/0 – L255:255/31 L9:0 – L255:255  
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6.2 SLC 500 Series 

 

 

Device Bit Address Word Address 32 bits Remarks 

Output File O000:000.00 – O063:255.15 O000:000 – O063:255 

L/H 

 

Input File I000:000.00 – I063:255.15 I000:000 – I063:255  

Bit File B003:000.00 – B003:255.15 

B009:000.00 – B255:255.15 

B003:000 – B003:255 

B009:000 – B255:255 

 

Timer File Coil  Done TC004:000.13 – TC004:255.13 

TC009:000.13 – TC255:255.13 

– 

 

 Timing TC004:000.14 – TC004:255.14 

TC009:000.14 – TC255:255.14 

 Enable TC004:000.15 – TC004:999.15 

TC009:000.15 – TC099:999.15 

 Preset – TP004:000 – TP004:255 

TP009:000 – TP255:255 

 Accumulated – TA004:000 – TA004:255 

TA009:000 – TA255:255 

Counter 

File 

Coil Update Acc CC005:000.10 – CC005:255.10 

CC009:000.10 – CC255:255.10 

– 

 

Underflow CC005:000.11 – CC005:255.11 

CC009:000.11 – CC255:255.11 

Overflow CC005:000.12 – CC005:255.12 

CC009:000.12 – CC255:255.12 

Done CC005:000.13 – CC005:255.13 

CC009:000.13 – CC255:255.13 

Down Enable CC005:000.14 – CC005:255.14 

CC009:000.14 – CC255:255.14 

Up Enable CC005:000.15 – CC005:255.15 

CC009:000.15 – CC255:255.15 

 Preset 
– 

CP005:000 – CP005:255 

CP009:000 – CP255:255 

 Accumulated 
– 

CA005:000 – CA005:255 

CA009:000 – CA255:255 

Integer File N007:000.00 – N007:255.15 

N009:000.00 – N255:255.15 

N007:000 – N007:255 

N009:000 – N255:255 

 

Floating Point File – F008:000 – F255:255 H/L  

 

 


